Student Guide for E-mail Setup

Prepared by
Information Technology Group
Table of Contents

**Activation CUNIX Network Services** .................................................. 3

**Netscape**

*Installing Netscape* .................................................................................. 4
*Configuring Netscape for CUNIX E-mail* .............................................. 6
*Configuring Netscape for LDAP Directory Lookup* .......................... 9

**Outlook XP**

*Configuring Outlook XP for CUNIX E-mail* ........................................ 11
*Configuring CUNIX as an Additional Outlook XP Account* .......... 13
*Configuring Outlook XP for LDAP Directory Lookup* .................. 14

**Outlook 2000**

*Configuring Outlook 2000 for CUNIX E-mail* ................................. 16
*Configuring CUNIX as an Additional Outlook 2000 Account* .... 19
*Configuring Outlook 2000 for LDAP Directory Lookup* ............... 19
Activating CUNIX Network Services

- Open your web browser (e.g. Netscape Navigator, Internet Explorer).
- In the Location/Address field type: http://www.columbia.edu/acis/accounts/create/create-form.html.
- Follow the instructions provided in this web page.

**NOTE**
At one point, the instructions will ask you whether you want to create a Basic account or an Extended account. Choose Basic! (There is an extra charge for Extended accounts, and if you find you want the extra storage they provide, you can always upgrade later.)

**IF YOU CANNOT USE YOUR E-MAIL...**
If you follow the above process, but still receive an incorrect password prompt when you try to access your e-mail, do not worry. Your e-mail password is not incorrect. The reason you are getting this prompt is because it takes at least 24 hours for the database containing your newly created e-mail password to turn over. If you are unable to access your account after 24 hours please contact the CUIT Help Desk at 212-854-1919.
Installing Netscape

1. Run the Netscape installer.

2. Click **Next** to begin installation.

3. Click **Accept** to acknowledge **Software License Agreement**.

4. Select the **Recommended** Setup Type and click **Next** to continue.

5. Click **Next** to create the default installation path.
6. Mark a check to include the **Sun Java 2** package with the installation.

7. Uncheck **Use Quick Launch for faster startup times when possible**. This will prevent system resources from being consumed by Netscape when the program is not being used.

8. If you would like to make **Netscape.com** your homepage, check the **box**. Then click **Next**.

9. If you would prefer to use your current homepage, leave the box unchecked and click **Next**.

10. Click **Install** to finish the installation.

11. The progress screen will display the installation of Netscape 7.0

12. After the program files are copied to your hard drive Netscape will automatically launch.
Configuring Netscape for CUNIX E-mail

1. If Netscape is not already running, open the application by clicking Start, Programs, Netscape 7.0, Netscape.

2. If you would like to make Netscape 7.0 your default internet browser, click Yes.

3. Otherwise, click No.

4. Click on the Window menu and select and click Mail & Newsgroups.

5. Select Email account. Then click Next.

6. Enter the name that you would like you recipients to see in the Your Name: field.

7. Enter you Lifetime email in the Email Address field.

8. Click Next.
9. Select POP as the type of incoming server to use.

10. For the Incoming Server enter POP.Columbia.edu

11. For the Outgoing Server enter Send.columbia.edu

12. Click Next

13. Enter your CUNIX ID as your user name.

14. Click Next

15. The account name should be Columbia Mail.

16. Click Next

17. Verify that all the information entered is correct and click Finish.

18. Click Next

19. When asked for your password, enter your CUNIX password.

20. If you wish to have Netscape remember your password, check the checkbox under the password field.

21. Click OK

22. Select Mail & Newsgroups Account Settings from the Edit menu
23. Select Server Setting under Columbia Mail on the left pane.

24. Check the Use secure connection (SSL) check box.

25. Select Outgoing Server (SMTP) on the left pane.

26. The Port field should be set to 465.

27. Check the User name and password

28. The User Name field should have you CUNIX ID

29. For the Use Secure Connection (SSL) setting, select Always.

30. Click OK

Install the Columbia Security Certificates by following the Digital Certificate Download Instructions from the CUIT website:
http://www.columbia.edu/acis/access/secure/ca.html?os=win&browser=ns6
If these certificates are not installed you will experience problems send emails.
Configuring Netscape for LDAP Directory Lookup

1. From the Netscape browser window, click the Edit menu and select Preferences....

2. In the Category listing, click the arrow next to Mail & Newsgroups, and then click Addressing.

3. Under Address Autocompletion, check the Directory Server address option.

4. Click the Edit Directories... button.

5. The window to the right will appear. Click the Add button.

6. In the Name: field, type “Columbia LDAP”.

7. In the Hostname: field, type “ldap.columbia.edu”.

8. Click OK.
9. In the Address Autocompletion section (next to the **Directory Server** address option), select the **Columbia LDAP** dropdown menu.

10. Click **OK**.

When you compose a message, information about your recipient (i.e. name, UNI, etc.) will automatically create a list of possible matches.
Configuring Outlook XP for CUNIX E-mail

**ALERT !!!**


1. Double-click the **Microsoft Outlook** icon on the desktop (or under the **Start menu – Programs** section). **Outlook 2002 Startup** window will appear. Click **Next**.

2. The next window will ask if you want to setup an e-mail account. Select **Yes** and click **Next**.

3. The window to the right will appear. Select **POP3** as the server type and click **Next**.

4. Under **User Information**:

5. Enter the name that you want recipients to see in the **Your Name:** field (i.e. "Jase T. English" or "Jase" or "J. English").

6. Enter your Lifetime E-mail Forwarding Address in the **E-mail Address:** field (i.e. JEnglish00@gsb.columbia.edu).

7. Under **Server Information**:

8. Enter "pop.columbia.edu" in the **Incoming mail server (POP3):** field.

9. Enter "send.columbia.edu" in the **Outgoing mail server (SMTP):** field.
10. Under Logon Information:

11. Enter your UNI in the User Name: field (i.e. jt2020).

12. For security reasons, do not enter a password in the Password: field. Also, uncheck the Remember Password box.

13. Click the More Settings... button.

14. Under the **General** tab, **Mail Account** section, there will be the information: “pop.columbia.edu”. Change this to **“Columbia POP - (your UNI)”**.

15. Click on the **Outgoing Server** tab.

16. Check the box for **My outgoing server (SMTP) requires authentication**.

17. Select Log on using.

18. Enter your **UNI** (University ID) in the **User Name**: field.

19. Enter your **University password** in the **Password**: field. Mark a check next to **Remember Password**.

20. Click on the **Advanced** tab.
21. Under the Server Port Numbers section you’ll find Incoming server (POP3): and Outgoing server (SMTP):. Check This server requires a secure connection (SSL) for both settings.

22. Click OK to close window.

23. Click Next to continue account setup.

24. Click Finish to finalize account.

Install the **Columbia Security Certificates** by following the Digital Certificate Download Instructions from the ACIS website:

http://www.columbia.edu/acis/access/secure/ca.html?os=win&browser=ie5

If these certificates are not installed you will experience problems send emails.

Close Outlook, reopen it and send a test email to a Columbia and non-Columbia email address. The first time you send an email it will prompt you to enter your password, which is normal for authenticated SMTP.

**Configuring CUNIX as an Additional Outlook XP Account**

*NOTE*
One account must already be setup before additional accounts can be created.

1. Open up Outlook. From the menu tool bar click Tools then E-mail Accounts....

2. Select Add a new e-mail account. Click Next.

3. Follow the instruction on pages 11-14 under Configuring Outlook XP for CUNIX E-mail
Configuring Outlook XP for LDAP Directory Lookup

Setup

1. Open up Outlook, from the menu toolbar click on **Tools** then highlight and click **E-mail Accounts**.

2. Select the **Add a new directory or address book**.

3. Click **Next**.

4. Select Internet Directory Service (LDAP) as the server type.

5. Click **Next**.

6. Under Server Information, for the **Server Name: field**, enter “ldap.columbia.edu”.

7. Click **Next**.

8. A prompt will appear stating that the account will not be in effect until Outlook is restarted. Click **OK**.

9. Click **Finish** to end the wizard.
Use

NOTE
This should be done after you have restarted Outlook from the previous section.

1. In the menu toolbar click the drop-down arrow on the New button, then highlight and click Mail Message.

2. Click on the To..., Cc..., or Bcc... buttons. (They will all bring you to the same window).

3. An address selection window will appear. In the Show Names from the: drop down box, make sure that ldap.columbia.edu is selected.

4. Click on the Find button.

5. A search window will appear. Enter the recipient’s information in the appropriate field. (I.e. if I’m looking for Jase English, I would put “Jase” in the “First name:” field and “English” in the “Last name:” field.).

ALERT!!!
Do not use the Display name: field because the search will yield no results.

6. Type the user’s name in the Name (i.e. “English”) field then press the Find Now button.

7. If you have entered only some of the recipient’s information, a list of possible matches will appear. Select the correct choice and click on either the To->, Cc->, or Bcc-> buttons to add the recipients to the mailing list for the message.

8. Click OK.
Configuring Outlook 2000 for CUNIX E-mail

Before setting up Outlook you must update The Operating System and Office with the latest product updates/patches from the Microsoft website.


Office update website: http://office.microsoft.com/productupdates. Press the Go button and install the updates that are indicated once your computer has been scanned, specifically any Service Packs.

1. Double-click the **Microsoft Outlook** icon on the desktop (or under the **Start** menu – **Programs** section). **Outlook 2000 Startup** window will appear. Click **Next**.

2. The window to the right will appear. Select **Internet Only** option and click **Next**.

3. Select **Yes** to continue.

4. Enter the name that you would like recipients to see in the **Display name** field (i.e. “Jase T. English” or “Jase” or “J. English”).

5. Click **Next**.

6. In the **E-mail address** field, enter your **Lifetime E-mail Forwarding Address** (i.e. JEnglish00@gsb.columbia.edu).
7. Ensure that POP3 is selected for the My incoming mail server is a ______ server. field.

8. For the Incoming mail server: field, type "pop.columbia.edu".

9. For the Outgoing mail server: field type "send.columbia.edu".

10. Click Next.

11. Enter in the Account name: field “Columbia POP - (your UNI)”.

12. For security reasons, do not enter a password in the Password: field. Also, uncheck the Remember Password box.

13. Select Connect using my local area network (LAN), then click Next.

14. Click on Finish at the next window.

15. In Outlook, go to the Tools menu item on the menu toolbar. Click on Accounts and select the Mail tab from the window that appears.

16. Highlight the pop.columbia.edu mail account and click Properties.
17. Click on the **Servers** tab.

18. Under **Outgoing Mail Server** section, check the box **My server requires authentication**.

19. Click on the **Settings** button.

20. Select Logon on using.

21. Enter your UNI in the Account name: field.

**NOTE**

If you do not enter your password and check Remember password, you will be prompted for your email password every time you try and send an email.

Enter your UNI password in the Password field and then click OK.

22. Click on the **Advanced** tab.

23. Under **Server Port Numbers** section you’ll find **Outgoing server (SMTP):** and **Incoming server (POP3):**. Check **This server requires a secure connection (SSL)** for both settings.

24. Click **Apply** button and then **OK**.

Install the **Columbia Security Certificates** by following the Digital Certificate Download Instructions from the ACIS website:

http://www.columbia.edu/acis/access/secure/ca.html?os=win&browser=ie5

If these certificates are not installed you will experience problems send emails.
Configuring CUNIX as an Additional Outlook 2000 Account

*NOTE*
One account must already be setup before additional accounts can be created.

1. Open up Outlook. From the menu tool bar click **Tools** then **Accounts**.

2. In the **Internet Accounts** window select the **Mail** tab. Press the **Add** button and highlight a click **Mail**.

3. Follow the instruction on pages 16-18 under Configuring Outlook for CUNIX E-mail (First Time Users) – Windows 2000.

Configuring Outlook 2000 for LDAP Directory Lookup

**Setup**

1. Open up Outlook, from the menu toolbar click on **Tools** then **Accounts**.

2. Select the **Directory Service** tab. Press the **Add** button, then highlight and select **Directory Services**....

3. In the Internet Directory (LDAP) server:” field enter "ldap.columbia.edu".

4. Click Next.

5. Select **Yes** to check addresses using the Columbia LDAP directory service.

6. Click **Next**.

7. Click **Finish** to end the wizard.
Use

NOTE
This should be done after you have restarted Outlook from the previous section.

1. In the menu toolbar click the drop-down arrow on the New button, then highlight and click Mail Message.

2. Click on the To..., Cc..., or Bcc... buttons. (They will all bring you to the same window).

3. In the Type name or select from list: field, type a recipient’s name and press the Find... button.

4. In the Look in: field, click on the drop down arrow to select the ldap.columbia.edu server.

5. Type the user’s name in the Name (i.e. “English”) field then press the Find Now button.

6. Highlight the specific recipient you were searching for from the search area and click on the corresponding send button; To..., Cc..., or Bcc.... Click on the Close button when all the recipients you have been searching for are queried and selected.